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СЪДЪРЖАНИЕ 



Потребителска настройка на цветовете 
За повечето управляeми цветови настройки, най-
добре е да използвате предварително зададените, 
които са тествани от Adobe Systems. Промяна на 
специфичните им опции се препоръчва само, ако сме 
добре информирани и уверени, какво точно правим. 
Работното цветово пространство е междинно 
пространство, което се използва за дефиниране и 
редактиране на цветове в приложенията на Adobe. 
Всеки цветови модел притежава асоциирано работно 
пространство, свързано с него. Можете да изберете 
такъв профил от далоговия прозорец "Color Settings".  



Потребителска настройка на цветовете 
Работното цветово пространство действа като 
източник за новосъздадения документ, който 
използват свързания с него цветови модел. Например, 
ако Adobe RGB (1998) е настоящото RGB пространство, 
всеки нов документ от този тип, който е създаден ще 
използва цветовете от Adobe RGB (1998) гамата.  
Ако отворите документ с вграден цветови профил, 
който не съответства на профила на работното 
пространство, приложението използва политика за 
управление на цвета (color management policy), за да 
определи как да възпроизведе цветовете. В повечето 
случаи, политиката по подразбиране е да се запази 
вграденият профил. 



Потребителска настройка на цветовете 
За да се покаже работното пространство като опции във Photoshop, 
Illustrator и InDesign, изберете Edit > Color Settings. В Acrobat, 
изберете категорията Color Management на диалоговия прозорец 
Preferences. 
RGB 
Определя цветовото пространство RGB на приложението. Като цяло, е 
най-добре да изберете Adobe RGB или sRGB, а не профила за 
конкретното устройство (като профил на съответния монитор, напр.). 
sRGB се препоръчва, когато подготвяте изображения за уеб, защото 
определя цветово пространство за стандартния монитор и се 
използва за преглеждане на изображения в мрежата. sRGB също е 
добър избор, когато работите с изображения от цифрови 
фотоапарати на потребителско ниво, тъй като повечето от тези 
камери използват sRGB като цвят по подразбиране. Adobe RGB е 
добро решение, когато работите файлове за печат, защото включва 
допълнителните циан и магента в гамата си. 



Потребителска настройка на цветовете 
CMYK 
Що се касае до CMYK цветовото пространство трябва 
да знаете, че всички производни работни 
пространства CMYK са зависими от устройството, на 
което ще се печата, мастилата и хартията. което 
означава, че те се основават на действителните 
комбинации с мастило и хартия. Adobe предоставя 
стандартните CMYK работни пространства, базирани 
на най-често срещаните видове печат. 



Цветови режими и пространства 
Adobe Photoshop ни предоставя няколко основни 
режима на работа с цветовете, налични от менюто: 
Image>Mode>…: 
Bitmap: Растерно (изображение) 
Grayscale: Сиво полутоново цветово пространство 
Duotone: Двутоново цветово пространство 
Indexed Color: С индексирани цветове 
RGB Color: RGB цветно цветово пространство 
CMYK Color: CMYK цветово пространство 
Lab Color: Lab цветно 
Multichannel: Многоканално 
8 Bits/Channel: 8 бита/канал 
16 Bits/Channel: 16 бита/канал 
32 Bits/Channel: 32 бита/канал 
Color Table: Цветова таблица 



Цветови профили 
 1. RGB режим (милиони цветове) 
 2. CMYK режим (4-цветен печат) 
     3. Index режим (256 цвята) 
     4. Grayscale режим (256 нюанса на сивото) 
     5. Bitmap режим (2 цвята) 



Потребителска настройка на цветовете 
Цветовият модел (color model) описва цветовете, с които 
работим. Всеки цветови модел (RGB, CMYK, HSB) представя 
различен метод за тяхното дефиниране. 
Цветовото пространство (color space) е вариант на цветовия 
модел и съдържа конкретен диапазон (gamut) от цветове. 
Например цветовият модел RGB има следните цветови 
пространства: Adobe RGB, sRGB, ProPhoto RGB, и други. 
Всяко устройство като монитор или принтер има свое 
цветово пространство и може да възпроизвежда само 
цветове от определен диапазон. Когато прехвърляме едно 
изображение от едно устройство към друго, цветовете могат 
да се променят понеже всяко устройство интерпретира по 
свой начин RGB или CMYK цветовите стойности. 



Цветови режими 
Съществуват различни цветови модели, дефиниращи 
цветовете, с които можем да работим.  
Сolor mode определя колко броя цветове могат да се 
включат в едно изображение. Различните цветови 
режими водят до различни нива на цветови детайли и 
размери на файла. 
Така например, цветният режим CMYK се използва за 
изображенията, нужни в една пълноцветна печатна 
брошура и увеличава големината на файлна, а за 
нейният онлайн вариант се използва  RGB се файловият 
размер намалява, като се поддържа целостта на 
цветовете. 



Цветови режими 
В RGB цветовия модел базовите цветове и канали са трите 
цвята на светлината (червен /Red/, зелен /Green/ и син 
/Blue/). Те могат да възпроизведат всички цветове във 
видимия спектър като се смесват в различни съотношения. 
Мониторите използват този цветови модел. Задаваме 
цветовете посредством стойности от 0 до 255. Ако всички 
цветови стойности са 255, получаваме бял цвят. 
CMYK цветовият модел представлява четирите цвята 
мастила в печатната индустрия (циян Cyan, магента 
Magenta, жълто Yellow и черно Black), при смесването на 
които получаваме всички останали. Цветовите стойности 
се задават в проценти. За белия цвят всички CMYK 
стойности са 0 %.  



Цветови режими 
Базиращ се на начина, по-който човек възприема цветовете, 
HSB модела описва трите основни характеристки на цвета: 
Hue (нюанс) - измерва се с положението на цвета в 
цветовия кръг, задава се в градуси от 0 до 360. Най-често 
нюанса се задава с името на цвета - red, orange, green. 
Saturation (наситеност) - Силата и чистотата на цвета. 
Наситеността представя количеството сиво в цвета, измерва 
се в процент от 0 (сиво) до 100 (наситен цвят). В 
стандартния цветови кръг, наситеността нараства от 
центъра към краищата. 
Brightness (осветеност) - Измерва се в проценти от 0 
(черно) до 100 (бяло). 



Цветови режими 
Моделът RGB осигурява достъп до по-голям обхват от 
цветове, отколкото можете да отпечатате. Ако правите 
изображение, предназначено за пълноцветен печат, 
можете да очаквате загуба на част от най-светлите и ярки 
цветове на вашето изображение.  
При CMYK, разглеждате единичен цветови канал. Черното 
означава висока интензивност на цвета, а бялото - ниска. 
Ако се опитате да постигнете наситени цветове, трябва да 
приложите черно към единичните цветови канали, а не 
бяло, както бихте направили в RGB режима. CMYK не 
може да постигне много ярки цветове, затова когато 
превключите от RGB на CYMK цветовете, те изглеждат 
“убити”.  



Цветови режими 
В HSB, Hue е чист цвят, изобразяващ цветовете на дъгата. 
Той се измерва чрез 360 градусов кръг. Червеното се 
намира на 0 градуса, жълтото на 60, зеленото на 120, 
цианът на 180, синъото на 240,а магентата на 300 градуса. 
Това е основна версия на RGB модела в пълна 
интензивност. 
Saturation представлява чистотата на цвета. Нулевата 
стойност на наситеност е еквивалентна на сиво, др. 
Пълната наситеност представя чистата версия на цвета. 
Brightness е осветеността или затъмнеността на цвета. 
Нулевата стойност е еквивалентна на черно (липса на 
светлина). Пълната brightness, комбинирана с пълна 
saturation, дава ярка версия, на който и да е цвят. 



Цветови режими 
Моделът LAB на CIE обхваща всички цветове от RGB и 
CMYK и е независим от светлината и пигментите. Този 
модел запълва дупките в предходните. Осигурява богат 
избор на цветове в синьо-зелената област, но е беден на 
жълти, оранжеви и др. 
Възможностите на режима включват три цветови канала – 
един за яркостта и два други за цветовата област (алфа и 
бета). Яркостта при Lab е като осветеността при HSB. 
Каналът алфа съдържа цветове вариращи от дълбоко 
зелено (ниско оцветено ), през сиво (средно осветено), до 
розово (високо оцветено). 



Цветови режими 
Каналът бета варира от светло синъо, през сиво, до горящо 
жълто и както в модела RGB тези цветове се сливат, за да 
образуват светли тонове. Само каналът за яркостта ги 
потъмнява. Така може да мислите за Lab като за 
двуканален RGB с определена яркост.  
Може да използвате Lab, за да редактирате някои 
изображения. Ако планирате да отпечатите 
изображението като цветоотделка, вие може да 
експерементирате с използването на Lab вместо RGB, 
защото осигурява конвертиране към CMYK без загуба на 
цветове, с изключение на цветовете, които са извън 
областта на CMYK.  



Цветови режими 

Тъй Lab описва как изглежда един цвят, а не какво 
оцветяване е необходимо за устройство (като 
монитор, настолен принтер или цифров 
фотоапарат), за да получи цветовете, Lab се счита 
за модел, независим от устройството. 
Системите за управление на цвета използват Lab 
като референтен цвят, за да определят 
трансформирането на цвят от едно пространство 
към друго цветово пространство. 



Цветови режими 
Тъй Lab описва как изглежда един цвят, а не какво 
оцветяване е необходимо за устройство (като монитор, 
настолен принтер или цифров фотоапарат), за да получи 
цветовете, Lab се счита за модел, независим от 
устройството. Системите за управление на цвета използват 
Lab като референтен цвят, за да определят 
трансформирането на цвят от едно пространство към друго 
цветово пространство. 
Режимът Lab Color има компонента осветеност 
(L=lightness), която може да варира от 0 до 100. В панела 
Adobe Color Picker, алфа компонента (зелено-червено ос) и 
бета компонент (синьо-жълта ос). Те варират от + 127 до -
128. 



Цветови режими 
Grayscale (нюанси на сивото), когато конвертирате 
изображение от някакъв цветови режим към grayscale, 
Photoshop обикновено преобразува стойностите на всеки 
цветови канал, така че да се запази видимата яркост на 
работното изображение. 
Всеки пиксел от едно такова изображение има яркост, 
варираща между 0 (черно) и 255 (бяло). В 16-bit 32-bit 
изображения, броят на нюансите е доста по-голям от този в 
8-bit картинки. 
Grayscale стойностите също се изберват в проценти на 
черното мастило (0% е бяло, 100% - черно). 
Grayscale моделът използва диапазон, определен от 
работното пространство, което сте избрали от Color Settings.  



Цветови режими 

Bitmap режимът се използва, за да конвертирате 
изображение само в черно-бели пиксели.  
Той използва двата цвята, за да пресъздаде 
пикселите в едно изображение.  
Картинките, които го използват се наричат битмапи 
(bitmapped) и представляват 1-bit изображения, 
защото притежават дълбочина на цвета 1.  



Цветови режими 

Режимът на цвят Bitmap често се използва при липса 
на векторна графична алтернатива. Ако са ви дали 
едноцветно лого върху бланка, вие може да го 
векторизирате по-бързо като го сканира и създадете 
Bitmap TIFF файл. Резултатното изображение ще 
няма да има anti-aliasing и по-лесно може да се 
изчертае, а даже и използва веднага.  



Цветови режими 
Indexed Color модел 
Индексираното пространство от цветове е това, което използвате 
при изобразяване с косвено дефинирани цветове. Стойността на 
индексирания цвят представлява стойност сочещо към определен 
индекс от списък с цветове. 
Indexed Color е същият като RGB модела и може да се разглежда 
като негова подсекция. Използвайки този модел, вие имате лимит 
от 256 цвята дефинирани от кои да е от 16,7-те милиона цвята от 
RGB модела. Софтуерни програми като Jasc's Paint Shop Pro не 
определят този модел като индексиран, а го отнасят към color 
depth (дълбочината на цвета). 
Индексираният цвят е много важен за GIF изображенията, а те са 
един от най-разпространените графични файлови формати в 
мрежата. 



Основи на цветовата корекция 

С програмата Adobe Photoshop може да направим 
различни по сложност цветови корекции. 
Един от най-лесните начини за бърза обработка на 
изображение е като използваме от менюто Image: 
oпциите Auto Tone (Автоматичен оттенък на 
цвета), Auto Contrast (Автоматичен контраст) 
или Auto Color (Автоматичен цвят) или някои от 
другите възможности, които ще разгледаме по-
късно. 
Друг интересен вариант е да създадем 
Adjustment слой. 



Панелът Adjustments 
 
 
 
 
 
Ако не виждате панела Adjustments, 
може да го отворите от менюто: 
Window > Adjustments 
 
 



Полезни клавишни комбинации 

За да увеличите или намалите размера на 
четката, може да натиснете „[“ или “]”. 
 
За да смените цвета на foreground с този на 
background, трябва да натиснете бутона „x“. 
 
За да редактирате Adjustment слой, трябва 
да кликнете върху иконката му.  
 
 



1) Отделете дамата от фона (с Refine Edges), показана 
във файла „ hair-homework“ и я монторайте върху 
друга снимка, по избор. 

2) Добавете Adjustments Blck&White слой във файла 
adjustment-layer-homework, но оставете цветята 
пълноцветни. 

3) Добавете layer маска на небето във файла change-
sky и направете цветовете по-наситени или 
монтирайте „по-слънчево“ небе от произволна 
картинка, избрана от вас. 

Домашна работа 02 



Литература 

I. Преведени основни команди и функции във Photoshop 
(макар и на по-ниската версия CS2): 
http://itschool.bg/tutorials/article/1288/ 

II. http://bgmasters.forum-2007.com/t84-topic 
III. http://myplace-online.info/ph_urok/color.php 
IV. http://antim1.com/Joomla2/index.php?option=com_content&ta

sk=view&id=344&Itemid=361 
V. https://helpx.adobe.com/photoshop/using/color-modes.html 
VI. http://myplace-online.info/ph_urok/color.php 
VII. https://helpx.adobe.com/photoshop/how-to/photo-

retouching.html?set=photoshop--key-techniques 
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